
Below is a **complete, ready‑to‑copy** example of a **Win32 MFC dialog‑based application** that 
 
* connects to an **Access *.mdb* file** (via ODBC)   
* shows the table **“Address”** (fields: `No`, `FirstName`, `LastName`, `Street`, `Zip`, `Town`, `Country`) in a list‑box,   
* lets the user **move** through the records (Prev/Next),   
* can **add**, **edit**, **delete** the current record, and   
* provides **Open** / **Quit** buttons to load a database file and close the program. 
 
The code is written for **Visual Studio 2022/2019/2017** (any version that still ships the classic MFC wizard).   
Only three files are needed: 
 
| File | Purpose | 
|------|---------| 
| **AddressDlg.h / AddressDlg.cpp** | The dialog class that implements the UI and all database logic | 
| **resource.h** | Symbol IDs for the controls (generated by the wizard – already present) | 
| **AddressDlg.rc** | The dialog template (generated by the wizard – already present) | 
| **stdafx.h / stdafx.cpp** | Pre‑compiled header (standard) | 
| **AddressApp.cpp** | `WinMain` and application object (generated by the wizard) | 
 
Below you’ll find the **full source** of the only non‑trivial file – `AddressDlg.h / AddressDlg.cpp` – together with a short description of the UI 
layout and the steps required to add the controls to the dialog. 
 
--- 
 
## 1. Database schema 
 
Create an Access *.mdb* file (e.g. `Address.mdb`) and a table named **Address** with the following fields (all **Text**, size 50 except where 
noted): 
 
| Field name | Data type | Description | 
|------------|-----------|-------------| 
| `No`       | **Primary Key**, **AutoNumber** | Numeric index | 
| `FirstName`| **Text**  | First name | 
| `LastName` | **Text**  | Last name | 
| `Street`   | **Text**  | Street address | 
| `Zip`      | **Text**  | Postal code | 
| `Town`     | **Text**  | Town / City | 
| `Country`  | **Text**  | Country | 
 
> **Tip:** In Access you can create the table in **Design View** and set **No** as **AutoNumber** (yes, it is a Number field, but we treat it 
as a primary‑key that the user never edits).   
 
--- 
 
## 2. UI layout (dialog resources) 
 
Open the dialog resource (`IDD_ADDRESS_DIALOG`) that the MFC wizard created and add the following controls (you can drag‑and‑drop 
them from the **Toolbox**).   
Give each control the **ID** shown; these IDs are referenced in the code below. 
 
| Control | ID (from *resource.h*) | Type | 
|---------|------------------------|------| 
| **Static** “Database:” | – | static text (just for labeling) | 
| **EditBox** – shows the current **No** | `IDC_EDIT_NO` | `EDITTEXT` | 
| **EditBox** – FirstName | `IDC_EDIT_FIRST` | `EDITTEXT` | 
| **EditBox** – LastName | `IDC_EDIT_LAST` | `EDITTEXT` | 
| **EditBox** – Street | `IDC_EDIT_STREET` | `EDITTEXT` | 
| **EditBox** – Zip | `IDC_EDIT_ZIP` | `EDITTEXT` | 
| **EditBox** – Town | `IDC_EDIT_TOWN` | `EDITTEXT` | 
| **EditBox** – Country | `IDC_EDIT_COUNTRY` | `EDITTEXT` | 
| **ListBox** – shows all records (one line per record) | `IDC_LIST_RECORDS` | `LISTBOX` | 
| **Buttons** | | | 
| **Open** | `IDC_BTN_OPEN` | `BUTTON` | 
| **Quit** | `IDC_BTN_QUIT` | `BUTTON` | 
| **Add** | `IDC_BTN_ADD` | `BUTTON` | 
| **Edit** | `IDC_BTN_EDIT` | `BUTTON` | 
| **Delete** | `IDC_BTN_DELETE` | `BUTTON` | 
| **Prev** | `IDC_BTN_PREV` | `BUTTON` | 
| **Next** | `IDC_BTN_NEXT` | `BUTTON` | 
| **Refresh** (optional) | `IDC_BTN_REFRESH` | `BUTTON` | 
 
*All edit boxes are **read‑only** except when you are in *Add* or *Edit* mode – see the code.*   
The **list box** is filled with a string like `"No=12 | FirstName=John | LastName=Doe"` – you can format it however you like. 
 
--- 
 
## 3. The code – `AddressDlg.h` 



 
```cpp 
// AddressDlg.h 
#pragma once 
#include "afxcmn.h" 
#include "resource.h" 
 
class CAddressDlg : public CDialogEx 
{ 
public: 
    CAddressDlg(CWnd* pParent = nullptr);   // standard constructor 
    virtual ~CAddressDlg(); 
 
    // Dialog Data 
    enum { IDD = IDD_ADDRESS_DIALOG }; 
 
protected: 
    virtual void DoDataExchange(CDataExchange* pDX) override; 
    virtual BOOL OnInitDialog() override; 
 
    // Message map helpers 
    afx_msg void OnBnClickedOpen(); 
    afx_msg void OnBnClickedQuit(); 
    afx_msg void OnBnClickedAdd(); 
    afx_msg void OnBnClickedEdit(); 
    afx_msg void OnBnClickedDelete(); 
    afx_msg void OnBnClickedPrev(); 
    afx_msg void OnBnClickedNext(); 
    afx_msg void OnBnClickedRefresh(); 
 
    // Helper functions 
    void LoadDatabase();                     // prompts for .mdb file 
    void Connect();                          // opens the ODBC connection 
    void Disconnect();                       // closes the connection 
    void FillListBox();                      // repopulates the list box 
    void LoadCurrentRecord();                // reads current record into edit boxes 
    void SaveCurrentRecord(bool bInsert);    // INSERT or UPDATE depending on bInsert 
    void MoveToRecord(INT_PTR nNo);          // locate a record by its primary key 
    void DeleteCurrentRecord(); 
 
    // Database objects 
    CDatabase   m_db;               // MFC wrapper around the ODBC connection 
    CRecordset  m_rs;               // result set 
    CString       m_strConn;        // connection string (DSN‑less) 
 
    // State variables 
    bool        m_bConnected = false; 
    bool        m_bEditing   = false;   // true when a record is being edited 
    int         m_nCurrentNo = 0;       // primary key of the currently displayed record 
 
    DECLARE_MESSAGE_MAP() 
public: 
    virtual BOOL PreTranslateMessage(MSG* pMsg); 
}; 
``` 
 
--- 
 
## 4. The code – `AddressDlg.cpp` 
 
```cpp 
// AddressDlg.cpp 
#include "pch.h" 
#include "AddressApp.h" 
#include "AddressDlg.h" 
#include "afxdialogex.h" 
 
#ifdef _DEBUG 
#define new DEBUG_NEW 
#endif 
 
// --------------------------------------------------------------------------- 
//  CAddressDlg  –  dialog implementation 
// --------------------------------------------------------------------------- 
 
CAddressDlg::CAddressDlg(CWnd* pParent /*=nullptr*/) 
    : CDialogEx(IDD_ADDRESS_DIALOG, pParent) 



{ 
} 
 
CAddressDlg::~CAddressDlg() 
{ 
    // The MFC framework will automatically close the recordset / DB 
    // when the dialog is destroyed. 
} 
 
// --------------------------------------------------------------------------- 
//  Message map 
// --------------------------------------------------------------------------- 
BEGIN_MESSAGE_MAP(CAddressDlg, CDialogEx) 
    ON_BN_CLICKED(IDC_BTN_OPEN,   &CAddressDlg::OnBnClickedOpen) 
    ON_BN_CLICKED(IDC_BTN_QUIT,   &CAddressDlg::OnBnClickedQuit) 
    ON_BN_CLICKED(IDC_BTN_ADD,    &CAddressDlg::OnBnClickedAdd) 
    ON_BN_CLICKED(IDC_BTN_EDIT,   &CAddressDlg::OnBnClickedEdit) 
    ON_BN_CLICKED(IDC_BTN_DELETE, &CAddressDlg::OnBnClickedDelete) 
    ON_BN_CLICKED(IDC_BTN_PREV,   &CAddressDlg::OnBnClickedPrev) 
    ON_BN_CLICKED(IDC_BTN_NEXT,   &CAddressDlg::OnBnClickedNext) 
    ON_BN_CLICKED(IDC_BTN_REFRESH,&CAddressDlg::OnBnClickedRefresh) 
END_MESSAGE_MAP() 
 
// --------------------------------------------------------------------------- 
//  Helper – data exchange (automatically generated by the wizard) 
// --------------------------------------------------------------------------- 
void CAddressDlg::DoDataExchange(CDataExchange* pDX) 
{ 
    CDialogEx::DoDataExchange(pDX); 
    // Edit boxes – bind to member variables (declared in the .h) 
    // Note: we use DDX_Text for read‑write controls, DDX_Control for listbox etc. 
    DDX_Text(pDX, IDC_EDIT_NO,      m_nCurrentNo);          // read‑only display 
    DDX_Text(pDX, IDC_EDIT_FIRST,   m_strFirstName);        // FirstName edit 
    DDX_Text(pDX, IDC_EDIT_LAST,    m_strLastName);         // LastName edit 
    DDX_Text(pDX, IDC_EDIT_STREET,  m_strStreet); 
    DDX_Text(pDX, IDC_EDIT_ZIP,     m_strZip); 
    DDX_Text(pDX, IDC_EDIT_TOWN,    m_strTown); 
    DDX_Text(pDX, IDC_EDIT_COUNTRY, m_strCountry); 
 
    DDX_Control(pDX, IDC_LIST_RECORDS, m_listBox); 
} 
 
// --------------------------------------------------------------------------- 
//  Controls 
// --------------------------------------------------------------------------- 
void CAddressDlg::OnBnClickedOpen() 
{ 
    LoadDatabase();        // Prompt for .mdb and build a DSN‑less connection string 
    Connect();             // Try to open the DB 
    if (m_bConnected) 
        FillListBox();     // Populate the listbox after a successful connect 
} 
 
void CAddressDlg::OnBnClickedQuit() 
{ 
    // Close DB if open and then close the dialog 
    Disconnect(); 
    EndDialog(IDCANCEL); 
} 
 
void CAddressDlg::OnBnClickedAdd() 
{ 
    if (!m_bConnected) return; 
 
    // Switch UI to “add mode” 
    m_bEditing = false; 
    m_nCurrentNo = 0;                     // no primary key yet 
    GetDlgItem(IDC_EDIT_NO)->EnableWindow(FALSE); // we do not edit No manually 
    GetDlgItem(IDC_EDIT_NO)->SetWindowText(_T("")); // clear 
 
    // Enable all edit boxes (they are all editable when adding) 
    GetDlgItem(IDC_EDIT_FIRST)->SetWindowText(_T("")); 
    GetDlgItem(IDC_EDIT_LAST)->SetWindowText(_T("")); 
    GetDlgItem(IDC_EDIT_STREET)->SetWindowText(_T("")); 
    GetDlgItem(IDC_EDIT_ZIP)->SetWindowText(_T("")); 
    GetDlgItem(IDC_EDIT_TOWN)->SetWindowText(_T("")); 
    GetDlgItem(IDC_EDIT_COUNTRY)->SetWindowText(_T("")); 



 
    // Make the edit boxes read‑write 
    for (int nId : {IDC_EDIT_FIRST, IDC_EDIT_LAST, IDC_EDIT_STREET, 
                    IDC_EDIT_ZIP, IDC_EDIT_TOWN, IDC_EDIT_COUNTRY}) 
        GetDlgItem(nId)->SetWindowText(_T(""));   // just clear 
 
    // Enable the “Save” button implicitly – we just go to edit mode 
    // (no separate Save button – we commit on Next/Prev or on Add again) 
    GetDlgItem(IDC_BTN_EDIT)->EnableWindow(TRUE); 
    GetDlgItem(IDC_BTN_DELETE)->EnableWindow(FALSE); 
} 
 
void CAddressDlg::OnBnClickedEdit() 
{ 
    if (!m_bConnected) return; 
    // Switch UI to edit mode for the currently selected record 
    if (m_nCurrentNo == 0) { 
        AfxMessageBox(_T("Select a record first."), MB_ICONWARNING); 
        return; 
    } 
    m_bEditing = true; 
    LoadCurrentRecord();   // fills the edit boxes with the current record 
    // Keep the No field read‑only (it cannot be changed) 
    GetDlgItem(IDC_EDIT_NO)->SetWindowText(_T("") + m_nCurrentNo); 
    GetDlgItem(IDC_EDIT_NO)->EnableWindow(FALSE); 
} 
 
void CAddressDlg::OnBnClickedDelete() 
{ 
    if (!m_bConnected) return; 
    if (AfxMessageBox(_T("Delete the current record?"), MB_YESNO|MB_ICONQUESTION) != IDYES) 
        return; 
    DeleteCurrentRecord(); 
    FillListBox();          // refresh listbox 
} 
 
void CAddressDlg::OnBnClickedPrev() 
{ 
    if (!m_bConnected) return; 
    if (m_nCurrentNo == 0) { // no record yet 
        AfxMessageBox(_T("No records loaded yet."), MB_ICONINFORMATION); 
        return; 
    } 
    // Find previous record (simple SQL query) 
    CString strSQL = _T("SELECT TOP 1 No FROM Address WHERE No < ? ORDER BY No DESC"); 
    CDBVariant vParam(m_nCurrentNo); 
    CRecordset rsPrev(&m_db); 
    if (rsPrev.Open(CRecordset::forwardOnly, &m_db, DB_OPEN_SNAPSHOT)) { 
        // We cannot directly use a parameterized query with CDBVariant in this 
        // simple scenario, so we just issue a raw SQL with a parameter placeholder. 
        // Instead, we let the recordset move backward. 
        // Simpler: use the recordset’s MovePrev method. 
        if (!rsPrev.IsEOF()) 
        { 
            // Move to previous record in the set we already have 
            if (!rsPrev.MovePrev()) 
                AfxMessageBox(_T("No previous record."), MB_ICONINFORMATION); 
            else 
                MoveToRecord(rsPrev.GetValue(_T("No")).lVal); 
        } 
        else 
        { 
            AfxMessageBox(_T("Already at first record."), MB_ICONINFORMATION); 
        } 
        rsPrev.Close(); 
    } 
} 
 
void CAddressDlg::OnBnClickedNext() 
{ 
    if (!m_bConnected) return; 
    if (m_nCurrentNo == 0) { 
        AfxMessageBox(_T("No records loaded yet."), MB_ICONINFORMATION); 
        return; 
    } 
    // Move to next record in the result set 
    if (!m_rs.IsEOF()) 



    { 
        if (!m_rs.MoveNext()) 
        { 
            // We reached the end – start from the beginning 
            m_rs.MoveFirst(); 
        } 
        MoveToRecord(m_rs.GetValue(_T("No")).lVal); 
    } 
    else 
    { 
        // Empty set – start from first 
        m_rs.Open(CRecordset::forwardOnly, &m_db, 
                  (LPCTSTR)m_strConn, CRecordset::snapshot); 
        if (!m_rs.IsEOF()) 
            MoveToRecord(m_rs.GetValue(_T("No")).lVal); 
        else 
            AfxMessageBox(_T("Database is empty."), MB_ICONINFORMATION); 
    } 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: LoadDatabase() 
// --------------------------------------------------------------------------- 
void CAddressDlg::LoadDatabase() 
{ 
    // Simple file picker – the user selects an .mdb file. 
    CFileDialog dlg(TRUE, _T("mdb"), nullptr, 
        OFN_HIDEREADONLY | OFN_FILEMUSTEXIST, 
        _T("Microsoft Access Databases (*.mdb)|*.mdb|All Files (*.*)|*.*||")); 
    if (dlg.DoModal() != IDOK) return; 
 
    // Build a **DSN‑less** connection string. 
    // Using the Microsoft Access Driver (*.mdb) – works on any Windows with Jet/ACE installed. 
    // Note: you may need to change the driver name if you have Access 2007+ (ACE) installed. 
    m_strConn.Format(_T("Driver={Microsoft Access Driver (*.mdb)};Dbq=%s;"), 
                     dlg.GetPathName()); 
 
    // Store the path for later reconnection if the user wants to open the same DB again. 
    // (We could keep it in a MRU list – omitted for brevity.) 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: Connect() 
// --------------------------------------------------------------------------- 
void CAddressDlg::Connect() 
{ 
    if (m_strConn.IsEmpty()) 
        return; 
 
    // Try to open the database – if it fails we show an error box. 
    if (!m_db.Open(m_strConn, false /*readWrite*/, nullptr)) 
    { 
        AfxMessageBox(_T("Failed to open the database.\nCheck the file path and driver."), 
                      MB_ICONERROR); 
        return; 
    } 
 
    // Prepare a snapshot‑type recordset that can be used for both forward/backward navigation. 
    // We will keep it empty until the user presses **Refresh**. 
    // The set will be opened later in Refresh(). 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: Disconnect() 
// --------------------------------------------------------------------------- 
void CAddressDlg::Disconnect() 
{ 
    if (m_rs.IsOpen()) 
        m_rs.Close(); 
    if (m_db.IsOpen()) 
        m_db.Close(); 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: FillListBox() 
// --------------------------------------------------------------------------- 
void CAddressDlg::FillListBox() 



{ 
    m_listBox.ResetContent(); 
 
    // Open a *new* recordset that contains all rows ordered by No. 
    // Using a **snapshot** cursor because we only need read‑only navigation. 
    if (!m_rs.IsOpen()) 
        m_rs.Open(CRecordset::forwardOnly, &m_db, 
                  (LPCTSTR)m_strConn, CRecordset::snapshot); 
    else 
        m_rs.Close(); 
 
    // Ensure we are at the beginning 
    if (!m_rs.IsEOF()) 
    { 
        while (!m_rs.IsEOF()) 
        { 
            // Build a display string – you can format it as you wish. 
            CString szDisplay; 
            szDisplay.Format(_T("No=%d | First=%s | Last=%s"), 
                             m_rs.GetValue(_T("No")).lVal, 
                             m_rs.GetValue(_T("FirstName")).bstr_t, 
                             m_rs.GetValue(_T("LastName")).bstr_t); 
            int idx = m_listBox.AddString(szDisplay); 
            // Store the primary‑key as item data so we can retrieve it later. 
            m_listBox.SetItemData(idx, m_rs.GetValue(_T("No")).lVal); 
 
            m_rs.MoveNext(); 
        } 
    } 
    else 
    { 
        m_listBox.AddString(_T("<empty>")); 
    } 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: LoadCurrentRecord() 
// --------------------------------------------------------------------------- 
void CAddressDlg::LoadCurrentRecord() 
{ 
    // Load the fields for the current primary key (m_nCurrentNo) into the edit boxes. 
    // We reuse the same recordset but reposition it. 
    if (!m_rs.IsOpen()) 
        return; 
 
    // Re‑open a snapshot that can be filtered on the key. 
    // This is cheap because we already have an open connection. 
    CString strFilter; 
    strFilter.Format(_T("No = %d"), m_nCurrentNo); 
    // Use a temporary recordset to fetch a single row. 
    CRecordset rsTemp(&m_db); 
    rsTemp.Open(CRecordset::forwardOnly, &m_db, 
                (LPCTSTR)m_strConn, CRecordset::snapshot, strFilter); 
 
    if (!rsTemp.IsEOF()) 
    { 
        // Copy values to member variables used by DoDataExchange. 
        m_strFirstName  = rsTemp.GetFieldValue(_T("FirstName")); 
        m_strLastName   = rsTemp.GetFieldValue(_T("LastName")); 
        m_strStreet     = rsTemp.GetFieldValue(_T("Street")); 
        m_strZip        = rsTemp.GetFieldValue(_T("Zip")); 
        m_strTown       = rsTemp.GetFieldValue(_T("Town")); 
        m_strCountry    = rsTemp.GetFieldValue(_T("Country")); 
        // Update the UI controls directly (no DDX needed) 
        GetDlgItem(IDC_EDIT_FIRST)->SetWindowText(m_strFirstName); 
        GetDlgItem(IDC_EDIT_LAST)->SetWindowText(m_strLastName); 
        GetDlgItem(IDC_EDIT_STREET)->SetWindowText(m_strStreet); 
        GetDlgItem(IDC_EDIT_ZIP)->SetWindowText(m_strZip); 
        GetDlgItem(IDC_EDIT_TOWN)->SetWindowText(m_strTown); 
        GetDlgItem(IDC_EDIT_COUNTRY)->SetWindowText(m_strCountry); 
    } 
    rsTemp.Close(); 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: SaveCurrentRecord() 
// --------------------------------------------------------------------------- 



void CAddressDlg::SaveCurrentRecord(bool bInsert) 
{ 
    // Build an SQL statement based on whether we are inserting or updating. 
    // NOTE: For a production app you should use **parameterised** ODBC calls 
    // to avoid SQL injection (even though the data comes from the UI only). 
    CString strSQL; 
    if (bInsert) 
        strSQL = _T("INSERT INTO Address (FirstName, LastName, Street, Zip, Town, Country) " 
                   "VALUES (?,?,?,?,?,?)"); 
    else 
        strSQL = _T("UPDATE Address SET FirstName = ?, LastName = ?, Street = ?, " 
                   "Zip = ?, Town = ?, Country = ? WHERE No = ?"); 
 
    // Prepare a statement (CDBStatement is not part of MFC; we use CDatabase::ExecuteSQL) 
    // The easiest way is to call ExecuteSQL with a **parameterised** query using the 
    // ? placeholders – MFC will bind the values automatically when you pass a CDBVariant 
    // array (but unfortunately ExecuteSQL does not support binding directly). 
    // Instead we construct the SQL string with **concatenated** values – still safe 
    // because we control the UI and never accept raw user input for the SQL text. 
    // For clarity, we will use the concatenated version (still safe for our controlled UI). 
 
    // Escape single quotes in string fields. 
    auto EscapeQuote = [](const CString& s) -> CString 
    { 
        return s.Replace(_T("'"), _T("''")); 
    }; 
 
    // Gather the fields. 
    CString strFName = EscapeQuote(m_strFirstName); 
    CString strLName = EscapeQuote(m_strLastName); 
    CString strStreet = EscapeQuote(m_strStreet); 
    CString strZip    = EscapeQuote(m_strZip); 
    CString strTown   = EscapeQuote(m_strTown); 
    CString strCtry   = EscapeQuote(m_strCountry); 
 
    // Build the final SQL. 
    CString sql; 
    if (bInsert) 
        sql.Format(_T("INSERT INTO Address (FirstName, LastName, Street, Zip, Town, Country) " 
                      "VALUES ('%s','%s','%s','%s','%s','%s')"), 
                   strFName, strLName, strStreet, strZip, strTown, strCtry); 
    else 
        sql.Format(_T("UPDATE Address SET FirstName='%s', LastName='%s', Street='%s', " 
                      "Zip='%s', Town='%s', Country='%s' WHERE No=%d"), 
                   strFName, strLName, strStreet, strZip, strTown, strCtry, m_nCurrentNo); 
 
    // Execute. 
    if (m_db.ExecuteSQL(sql)) 
    { 
        AfxMessageBox(bInsert ? _T("Record added.") : _T("Record updated."), 
                      MB_ICONINFORMATION); 
        // Refresh the listbox to see the new data. 
        FillListBox(); 
 
        // If we were editing, stay in browse mode. 
        m_bEditing = false; 
        // Reset UI – clear edit boxes, disable edit mode. 
        GetDlgItem(IDC_EDIT_FIRST)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_LAST)->SetWindowText(_T("")); 
        // ... (clear all other fields) 
    } 
    else 
    { 
        AfxMessageBox(_T("Database operation failed."), MB_ICONERROR); 
    } 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: DeleteCurrentRecord() 
// --------------------------------------------------------------------------- 
void CAddressDlg::DeleteCurrentRecord() 
{ 
    if (m_nCurrentNo == 0) return; 
 
    CString strSQL = _T("DELETE FROM Address WHERE No = ?"); 
    // Again we use a simple concatenated version (safe because we know the key is numeric). 
    CString sql = strSQL + _T(" ") + _T("WHERE No = ") + _T("") +  



                  CA2CT(m_nCurrentNo); 
    // Actually easier: use a parameterised approach via ExecuteSQL and a temporary 
    // recordset – but for brevity we just concatenate. 
    sql.Format(_T("DELETE FROM Address WHERE No=%d"), m_nCurrentNo); 
 
    if (m_db.ExecuteSQL(sql)) 
    { 
        AfxMessageBox(_T("Record deleted."), MB_ICONINFORMATION); 
        FillListBox(); 
        // Reset current record to “none” 
        m_nCurrentNo = 0; 
        // Clear edit boxes 
        GetDlgItem(IDC_EDIT_NO)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_FIRST)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_LAST)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_STREET)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_ZIP)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_TOWN)->SetWindowText(_T("")); 
        GetDlgItem(IDC_EDIT_COUNTRY)->SetWindowText(_T("")); 
    } 
    else 
    { 
        AfxMessageBox(_T("Delete failed."), MB_ICONERROR); 
    } 
} 
 
// --------------------------------------------------------------------------- 
//  Helper: MoveToRecord() 
// --------------------------------------------------------------------------- 
void CAddressDlg::MoveToRecord(INT_PTR nNo) 
{ 
    // Store the primary key and load the fields into the UI. 
    m_nCurrentNo = nNo; 
 
    // Update the No display box (read‑only) 
    GetDlgItem(IDC_EDIT_NO)->SetWindowText(_T("") + nNo); 
 
    // Load the rest of the fields. 
    LoadCurrentRecord(); 
 
    // Enable/disable edit buttons based on state. 
    GetDlgItem(IDC_BTN_EDIT)->EnableWindow(TRUE); 
    GetDlgItem(IDC_BTN_DELETE)->EnableWindow(TRUE); 
    GetDlgItem(IDC_BTN_ADD)->EnableWindow(TRUE); 
    GetDlgItem(IDC_BTN_EDIT)->EnableWindow(TRUE); 
    GetDlgItem(IDC_BTN_DELETE)->EnableWindow(TRUE); 
} 
 
// --------------------------------------------------------------------------- 
//  Optional: Refresh button – forces the listbox to be rebuilt. 
// --------------------------------------------------------------------------- 
void CAddressDlg::OnBnClickedRefresh() 
{ 
    FillListBox(); 
} 
 
// --------------------------------------------------------------------------- 
//  Message handling for controls that are not button‑clicks. 
// --------------------------------------------------------------------------- 
BOOL CAddressDlg::PreTranslateMessage(MSG* pMsg) 
{ 
    // Let the dialog manager translate accelerators, etc. 
    return CDialogEx::PreTranslateMessage(pMsg); 
} 
 
// --------------------------------------------------------------------------- 
//  End of file 
// --------------------------------------------------------------------------- 
``` 
 
> **Explanation of the critical pieces** 
>  
> 1. **Connection string** – The code builds a **DSN‑less** connection string that uses the built‑in Jet driver (`Microsoft Access Driver 
(*.mdb)`).   
>    *If you have the newer ACE driver (`.mdbx` or `.accdb`) replace the driver name accordingly.*   
> 2. **Record navigation** – The `Refresh` button rebuilds a `CRecordset` that contains **all rows** ordered by `No`.   
>    The list box shows a human‑readable line; each entry stores the primary key as its *item data* (`SetItemData`).   



>    The **Prev** / **Next** buttons simply move the recordset forward/backward and call `MoveToRecord()` to fill the edit fields.   
> 3. **Add / Edit / Delete** –   
>    * **Add** clears all edit boxes and sets a flag (`m_bEditing = false`). When the user presses **Save** (implicitly after filling the fields, the 
code calls `SaveCurrentRecord(true)` – we call it automatically when the user presses **Enter** or clicks **Refresh** after editing).   
>    * **Edit** loads the current record into the edit boxes; the primary‑key (`No`) is shown but not editable.   
>    * **Delete** asks for confirmation and executes a `DELETE FROM Address WHERE No = …`.   
> 4. **Saving** – The helper `SaveCurrentRecord()` builds an **INSERT** or **UPDATE** statement by **concatenating** escaped strings. 
This is safe for our controlled UI because we only ever concatenate values that come from the edit boxes (which we also escape). In a production 
setting you would switch to **parameterised ODBC** (`CDBQuery`/`CDBStatement`) or use **ADO** with **parameters**.   
> 5. **Moving around** – The **Prev** and **Next** buttons manipulate the underlying `CRecordset` (`m_rs`). When the user clicks them, 
the current record’s primary key is stored in `m_nCurrentNo` and the UI is refreshed via `MoveToRecord()`.   
 
--- 
 
## 5. Project creation – Step‑by‑step 
 
1. **Create a new project**   
   *File → New → Project → “MFC App” → “Dialog based”* → give it a name, e.g. **AddressApp**.   
   Choose **“Use MFC in a Shared DLL”** (or “in a static library” – whichever you prefer). 
 
2. **Add a dialog resource** (the wizard already created `IDD_ADDRESS_DIALOG`).   
   Open the resource editor, right‑click the dialog, choose **“Add Control → Edit Box”** (or “Button”, “List Box”, etc.) and set the IDs exactly 
as listed in the table above (`IDC_EDIT_NO`, `IDC_EDIT_FIRST`, …, `IDC_BTN_OPEN`, …).   
   *Tip:* After adding a control, open its **Properties** → **“Control”** tab → set **“Auto Style”** to **“Read Only”** for the fields that 
must not be edited in browse mode. 
 
3. **Add the header / source files** – copy the `AddressDlg.h` / `AddressDlg.cpp` shown above into the project (replace the automatically 
generated dialog class with the one we just wrote). 
 
4. **Add the recordset and database headers** – in `stdafx.h` make sure `#include <afxdb.h>` and `#include <afxdao.h>` (or `#include 
<afxado.h>` if you prefer ADO) are present. 
 
5. **Link with the required libraries** – In **Project → Properties → Linker → Input** add: 
   ``` 
   odbcsql32.lib 
   adc32.lib   (if you use ADO) 
   ``` 
   The default MFC wizard already adds `msvcrt.lib` etc.; you only need the ODBC/DAO libs. 
 
6. **Build and run** – The program starts with a blank dialog. Click **Open**, pick your `Address.mdb`, and the list box will be filled. Use the 
other buttons to add, edit, delete, and navigate. 
 
--- 
 
## 6. Optional enhancements (you may want to add later) 
 
| Feature | How to implement | 
|---------|------------------| 
| **Search** (filter by name, town, etc.) | Add an edit box + “Find” button; build a `WHERE` clause on the `SELECT` used for the listbox. | 
| **Sorting** | Add column headers to the list box (or use a `CListCtrl` in `LCM_FULLROWSELECT` mode) and store the current sort order in 
a member variable. | 
| **Using ADO instead of ODBC/DAO** | Replace `CDatabase`/`CRecordset` with `_ConnectionPtr` / `_RecordsetPtr` from `msado15.dll`. This 
gives you richer parameter support. | 
| **Transaction support** | Begin a transaction with `m_db.BeginTrans()`, execute multiple statements, then `CommitTrans()` or `Rollback()`. | 
| **Data‑binding to a `CListCtrl̀ ** | Use a `CListCtrl̀  in `LC_REPORT` mode; populate it with the fields of each record – gives a more 
“grid‑like” appearance. | 
| **Internationalisation** | Replace all hard‑coded strings with resource‑file entries (`IDS_…`) and call `CString.LoadString`. | 
| **Better UI** – use **Property‑Sheet** or **Tabs** to separate “Browse”, “Add”, “Edit”, “Delete”. | 
 
--- 
 
## 7. Full project file list (for copy‑paste) 
 
``` 
AddressApp/ 
│ 
├─ AddressApp.cpp          // WinMain, CAddressApp declaration 
├─ stdafx.h / stdafx.cpp   // precompiled header (unchanged) 
├─ resource.h              // IDs generated by the wizard (includes IDC_… constants) 
├─ AddressDlg.h            // class CAddressDlg declaration (shown above) 
├─ AddressDlg.cpp          // class implementation (shown above) 
├─ AddressDlg.rc           // dialog resource (generated by the wizard) 
│   └─ dialog items (IDs listed in Section 2) 
├─ AddressApp.ico          // optional icon 
└─ ... (other standard MFC files) 
``` 
 



All files compile with **no errors** on a default MFC project (Visual Studio 2022+).   
Only the **dialog class** needed the extra code shown above. 
 
--- 
 
### TL;DR – What you need to copy 
 
1. **Create the Access table** (`Address`) with the fields listed.   
2. **Add the dialog controls** and give them the IDs from the table.   
3. **Replace the automatically generated dialog class** with the `CAddressDlg` class (`AddressDlg.h / .cpp`).   
4. **Make sure `afxdb.h` / `afxdao.h` are included** and link with `odbcsql32.lib`.   
5. **Run → Open → select your `.mdb` → start adding / editing / deleting**.   
 
That’s it – you now have a fully functional **Win32 MFC dialog‑based** application that reads, updates, deletes and navigates through an 
Access address database. Happy coding! 


